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Preface

MATLAB® is a very popular language for technical computing used by stu-
dents, engineers, and scientists in universities, research institutes, and industries
all over the world. The software is popular because it is powerful and easy to use.
For university freshmen in it can be thought of as the next tool to use after the
graphic calculator in high school.

This book was written following several years of teaching the software to
freshmen in an introductory engineering course. The objective was to write a book
that teaches the software in a friendly, non-intimidati %%,Therefore, the
book is written in simple and direct language. In many pJaces bullets, rather than
lengthy text, are being used to list facts and details that are related to a specific
topic. The book includes numerous sample problems in mathematics, science, and
engineering that are similar to problems encountered by new users of MATLAB.

This second edition of the book is updated for MATLAB 7. It includes also
a new chapter (11) about symbolic math operations with MATLAB, and a new
section in Chapter 4 that shows how to import and export data.

I would like to thank several of my colleagues at The Ohio State University.
Professors Richard Freuler, Mark Walter, Brian Harper, and Walter Lampert, and
Dr. Mike Parke for reading sections of the book and suggesting modifications. I
also appreciate the involvement and support of Professors Robert Gustafson and
John Demel and Dr. John Merrill from the First-Year Engineering Program at The
Ohio State University. Special thanks to Professor Mike Lichtensteiger (OSU),
and my daughter Tal Gilat (Stanford University), who carefully reviewed the
entire book and provided valuable comments and criticisms.

I would like to express my appreciation to all those who have reviewed this
text at its various stages of development, including Betty Barr, University of
Houston; Andrei G. Chakhovskoi, University of California, Davis; Roger King,
University of Toledo; Richard Kwor, University of Colorado at Colorado Springs;
Larry Lagerstrom, University of California, Davis; Yueh-Jaw Lin, University of
Akron; H. David Sheets, Canisius College; Geb Thomas, University of Iowa;
Brian Vick, Virginia Polytechnic Institute and State University; Jay Weitzen, Uni-
versity of Massachusetts, Lowell; and Jane Patterson Fife, The Ohio State Univer-
sity. In addition, I would like to acknowledge the support of Joe Hayton, Ken
Santor, Caroline Sieg, Katherine Hepburn, Simon Durkin, John Stout, and Jay
Beck, all from John Wiley & Sons.

I hope that the book will be useful and will help the users of MATLAB to
enjoy the software.

Amos Gilat
Columbus, Ohio
May, 2004
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To my parents Schoschana and Haim Gelbwacks
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Introduction
bl A S

MATLAB/ is a powerful language for technical computing.
stands for MATrix LABoratory, because its basic data element is a matrix (array).
MATLAB can be used for math computations, modeling and simulations, data‘ i} /
analysis and processing, visualization and graphics, and algorithm development. f',fa "J; i ;'T }MZZ/%
MATLAB is widely used in universities and colleges in introductory and ‘ ')
advanced courses in mathematics, science, and especially in engineering. In
industry the software is used in research, development and design. The standard
MATLAB program has tools (functions) that can be used to solve common prob-
lems. In addition, MATLAB has optional toolboxes that are a collection of spe-
cialized programs designed to solve specific types of problems. Examples include
toolboxes for signal processing, symbolic calculations, and control systems.
Until recently, most of the users of MATLAB have been people who had
previous knowledge of programming languages such as FORTRAN or C, and
switched to MATLAB as the software became popular. Consequently, the major-
ity of the literature that has been written about MATLAB assumes that the reader
has knowledge of computer programming. Books about MATLAB often address
advanced topics, or applications, that are specialized to a particular field. In the
last few years, however, MATLARB is being introduced to college students as the
first (and sometimes the only) computer program they learn. For these students
there is a need for a book that teaches MATLAB assuming no prior experience in
computer programming.

The Purpose of this Book

MATLAB: An Introduction with Applications is intended for students who are
using MATLAB for the first time and have little or no experience in computer pro-
gramming. It can be used as a textbook in freshmen engineering courses, or work-
shops where MATLAB is being taught. The book can also serve as a reference in
more advanced science and engineering courses when MATLAB is used as a tool
for solving problems. It also can be used for self study of MATLAB by students
and practicing engineers. In addition, the book can be a supplement or a secondary
book in courses where MATLAB is used, but the instructor does not have the time
to cover it extensively.

Topics Covered

MATLARB is a huge program, therefore it is impossible to cover all of it in one
book. This book focuses primarily on the foundations of MATLAB. It is believed
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that once these foundations are well understood, the student will be able to learn
advanced topics easily by using the information in the Help menu.

The order in which the topics are presented in this book was chosen care-
fully, based on several years of experience in teaching MATLAB in an introduc-
tory engineering course. The topics are presented in an order that allows the
student to follow the book chapter after chapter. Every topic is presented com-
pletely in one place and then is used in the following chapters.

The first chapter describes the basic structure and features of MATLAB and
how to use the program for simple arithmetic operations with scalars as with a cal-
culator. The next two chapters are devoted to the topic of arrays. MATLAB’s basic
data element is an array that does not require dimensioning. This concept, which
makes MATLAB a very powerful program, can be a little difficult to grasp for stu-
dents that have only limited knowledge and experience with linear algebra and
vector analysis. The book is written such that the concept of arrays is introduced
gradually and then explained in extensive detail. Chapter 2 describes how to cre-
ate arrays, and Chapter 3 covers mathematical operations with arrays.

Following the basics, script files are presented next in Chapter 4, followed
by two-dimensional plotting in Chapter 5. The next topic covered, in Chapter 6, is
function files, which is intentionally separated from the subject of script files. This
has been proven to be easier to understand by students who are not familiar with
similar concepts from other computer programs. Programming with MATLAB is
covered in Chapter 7, which includes flow control with conditional statements and
loops.

The next three chapters cover more advanced topics. Chapter 8 describes
how MATLAB can be used for carrying out calculations with polynomials, and
how to use MATLAB for curve fitting and interpolation. Plotting three-dimen-
sional plots, which is an extension of the chapter on two-dimensional plots, is cov-
ered in Chapter 9. Chapter 10 covers applications of MATLAB for numerical
analysis. It includes solving nonlinear equations, finding a minimum or a maxi-
mum of a function, numerical integration, and solution of first order ordinary dif-
ferential equations. Chapter 11 is a new chapter that was added to the second
edition of the book. It covers in great detail how to use MATLAB in symbolic
operations.

The Framework of a Typical Chapter

In every chapter the topics are introduced gradually in an order that makes the
concepts easy to understand. The use of MATLAB is demonstrated extensively
within the text and by examples. Some of the longer examples in Chapters 1-3 are
titled as tutorials. Every use of MATLAB is printed in the book with gray back-
ground. Additional explanations appear in boxed text with white background. The
idea is that the reader will execute these demonstrations and tutorials in order to
gain experience in using MATLAB. In addition, every chapter includes formal
sample problems which are examples of applications of MATLAB for solving
problems in math, science, and engineering. Each example includes a problem
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statement and a detailed solution. Some sample problems are presented in the
middle of the chapter. All of the chapters (except Chapter 2) have a section at the
end with several sample problems of applications. It should be pointed out that
problems with MATLAB can be solved in many different ways. The solutions of
the sample problems are written such that they are easy to follow. This means that
in many cases the problem can be solved by writing a shorter, or sometimes
“trickier,” program. The students are encouraged to try to write their own solu-
tions and compare the end results. At the end of each chapter there is a set of
homework problems. They include general problems from math and science and
problems from different disciplines of engineering.

Symbelic Calculations

MATLAB is essentially a software for numerical calculations. Symbolic math
operations, however, can be executed if the Symbolic Math toolbox is installed.
The Symbolic Math toolbox is included in the student version of the software and
can be added to the standard program.

Software and Hardware

The MATLAB program, like most other software, is continually being developed
and new versions are released frequently. This book covers MATLAB, Version 7,
Release 14. It should be emphasized, however, that this book covers the basics of
MATLAB which do not change that much from version to version. The book cov-
ers the use of MATLAB on computers that use the Windows operating system and
almost everything is the same when MATLAB is used on other machines. The
user is referred to the documentation of MATLAB for details on using MATLAB
on other operating systems. It is assumed that the software is installed on the com-
puter, and the user has basic knowledge of operating the computer.

The Order of Topics in the Book

It is probably impossible to write a textbook where all the subjects are presented
in an order that is suitable for everyone. The order of topics in this book is such
that the fundamentals of MATLAB are covered first (arrays and array operations),
and, as mentioned before, every topic is covered completely in one location which
makes the book easy to use as a reference. Some people, however, might want to
follow a slightly different order, especially when the book is used as a text in a
MATLAB class. For example, some teachers may cover the basics of script files
(the first four sections of Chapter 4), before teaching Chapter 2 (creating arrays)
and Chapter 3 (arrays operations). This will allow students to use script files
instead of the Command Window when studying Chapters 2 and 3. Also, rela-
tional and logical operations (Section 7.1) and polynomials (Section 8.1) can be
considered mathematical operations and presented together with the rest of the
operations in Chapter 3.






Chapter 1
Starting with
MATLAB

This chapter begins by describing the characteristics and purposes of the different
windows in MATLAB. Next, the Command Window is introduced in detail and is
the only one that is used in the rest of the chapter. Chapter 1 shows how to use
MATLAB for arithmetic operations with scalars, similar to the way that a calcula-
tor is used. This includes the use of elementary math functions with scalars. The
chapter then shows how to define scalar variables (the assignment operator) and
how to use these variables in arithmetic calculations.

1.1 STARTING MATLAB, MATLAB WINDOWS

It is assumed that the software is installed on the computer, and that the user can
start the program. Once the program starts, the window that opens, shown in Fig-
ure 1-1, contains three smaller windows which are the Command Window, the
Current Directory Window, and the Command History Window. This is the
default view of MATLAB. These windows are three of eight different windows in
MATLAB. A list of the various windows and their purpose is given in Table 1-1.
The Start button on the lower left side can be used to access MATLAB tools and
features.

Four of the windows, the Command Window, the Figure Window, the Editor
Window, and the Help Window, are used extensively throughout the book and are
briefly described on the following page. More detailed descriptions are included
in the chapters where they are used.

Command Window: The Command Window is MATLAB’s main window, and
opens when MATLARB is started. It is convenient to have the Command Window
as the only visible window, and this can be done by either closing all the other
windows (click on the x at the top right-hand side of the window you want to
close), or by first selecting on the Desktop Layout in the Desktop manu, and then
Command Window Only from the submenu that opens. How to work in the
Command Window is described in detail in Section 1.2.
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Figure 1-1: The default view of MATLAB desktop.

Table 1-1: MATLAB Windows

Window Purpose

Command Window Main window, enters variables, runs
programs.

Figure Window Contains output from graphic com-
mands.

Editor Window Creates and debugs script and func-
tion files. Be %

Help Window Provides help information.

Launch Pad Window Provides access to tools, demos, and
documentation.

Command History Window | Logs commands entered in the Com-
mand Window.

Workspace Window Provides information about the vari-
ables that are used.

Current Directory Window | Shows the files in the current direc-
tory.

Figure Window: The Figure Window opens automatically when graphics com-
mands are executed, and contains graphs created by these commands. An example
of a Figure Window is shown in Figure 1-2. A more detailed description of this
window is given in Chapter 5.



1.1 Starting MATLAB. MATLAB Windows

4 Figure 1
File Edit View Insert Tools Deskiop Window Help

Figure 1-2: Example of a Figure Window.

Editor Window: The Editor Window is used for writing and editing programs.
This window is opened from the File menu in the Command Window. An exam-
ple of an Editor Window is shown in Figure 1-3. More details on the Editor Win-
dow are given in Chapter 4 where it is used for creating script files, and in Chapter
6 where it is used to create function files.

@ Editor - E\Chapter 1WProgramExample.m
File Edt Text Cell Tools Debug Desktop Window Help
NsE ' @cc & MfF 08

% This program calculates the sin of the sgquare root of x.

% X has wvalues 1, 2, 3, 4, 5, 6, 7, &8, and 9.
¢

5 The calculated value y is displavyed.

= Xx=1:9;
= v=sinisqgrt (x))

o

| script n 1 Col 1 R
U e e S PNt vl
Figure 1-3: Example of an Editor Window.

Help Window: The Help Window contains help information. This window can
be opened from the Help menu in the toolbar of any MATLAB window. The Help
Window is interactive and can be used to obtain information on any feature of
MATLAB. Figure 1-4 shows an open Help Window.

When MATLARB is started for the first time the screen looks like that shown in
Figure 1-1 on page 6. For most beginners it is probably convenient to close all the
windows except the Command Window. The closed windows can be reopened by
selecting them from the Desktop menu. The windows shown in F igure 1-1 can be
displayed by first selecting Desktop Layout in the Desktop menu and then
Default from the submenu.
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Figure 1-4: The Help Window.

1.2 WORKING IN THE COMMAND WINDOW

The Command Window is MATLAB’s main window, and can be used for execut-
ing commands, opening other windows, running programs written by the user, and
managing the software. An example of the Command Window, with several sim-
ple commands that will be explained later in this chapter, is shown in Figure 1-5.

7 AR 8
File Edit Debug Desktop Window Help
O G'-"E 4 Ba @ o o i& ﬁs ? § Current Directory: | c:\matlab7wvork v . ®

Shortcuts [@] Howto Add (] What's New

>> 2%(443)
ans =

14
>> a=5;
5> b=3; To type a command the cursor is placed
>> a*tb next to the command prompt ( >>).
ans =

Figure 1-5: The Command Window.



